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ABSTRACT 

In gas turbines, the temperature behind the combustors is the highest, meaning 
that the blades in the first stage of the turbine require cooling air. This makes the 
structural blade model very detailed due to the presence of the cooling pattern. For 
aeromechanical design, one of the first steps is to perform a modal frequency 
check by using 3d Finite Element models and the Campbell diagram to establish if 
the design is acceptable with respect to resonance margins. If the 3d detailed 
geometry (including all the cooling details) is used the model becomes extremely 
large. In order to perform various loops between structural dynamics and 
aerodynamics in an early stage, the dynamic model of cooled blades should be 
simplified. The simplified model should be accurate enough in terms of predicting 
correct frequencies but much lighter in size.  
 
The objective of this thesis is to perform parametric studies of different 3d 
simplified cooled turbine blade models. Various models with different geometrical 
features are created from the history of the CAD software (NX). Different FE 
meshes are produced in the Hypermesh software and the modal analyses are 
solved in Abaqus. The results are compared with the fully detailed model. The 
influence of the cooling features for each test case is summarized and this will be 
useful for creating reduced order models. Explanation and guidelines with respect 
to the mesh generation and loading conditions in Hypermesh software are also 
included in the appendix section.   

 
For quick frequency checks during the intial stages of the design, the solid blade 
model can be used which has the modal frequencies within 10 percent range from 
the fully detailed model. The cooling core features that are important with respect 
to dynamics are cooling matrix, the ribs and the trailing edge cutback which 
contribute to the stiffness of the blade.  
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NOMENCLATURE 

 
Latin Symbols 
 
a  Acceleration 
C  Damping 
K  Stiffness 
M  Mass  
ND  Nodal Diameter 
t  Time 
V  Volume 

v  Velocity 
x  Displacement 
 
Greek Symbols 
 
 
ρ  Density    
ω  Frequency 
 
Subscripts 
 
r  damped 
 
Abbreviations 
 
AG   Aktiengesellschaft  
AIAA  American Institute of Aeronautics and Astronautics 
ASME  The American Society of Mechanical Engineers 
CT                                   Compressor Turbine  
FE  Finite Element 
TIT   Turbine Inlet temperature 
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1 INTRODUCTION 

Gas turbines play an important role in the industrialized society. Today, the 
production of power becomes a demand and due to that, the thermal efficiency 
and power output of the gas turbine becomes significant. One technique that 
increases the thermal efficiency and power output of a gas turbine is to increase 
the temperature of the gas entering the turbine.  For increasing the temperature, 
cooling in the first two stages of the turbine has become a significant part.  
 
 

 
 

a)    b) 
 

Figure 1.1 Design process with dynamics with full 3d geometry (a); design process with 
simplified dynamics model (b).  

 
During the design process of the turbine, estimating the natural frequencies is 
required.  The natural modes of a system are those at which the system will 
vibrate with the highest amplitudes when excited at the corresponding natural 
frequencies. When the natural modes are excited, it is said that the system is in 
resonance. In gas turbines, resonance at the lower natural frequencies of the 
blades becomes a danger when it happens in the operating range. The blade 
dynamics specialists should then be involved in the estimation of the natural 
frequencies in the design process. This process generally starts in the 
aerodynamics group, where the blade is designed optimizing for efficiency. At this 
stage, definition of the blade profile is assessed. The cooling group will then 
implement the cooling core details of the blade optimizing for heat transfer and 
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thermal efficiency. The cooling core changes the properties of the structure (i.e.: 
mass, stiffness, etc.). Then, the CAD designers will create the 3d geometry to 
manufacture. This geometry is the basis for the generation of the full 3d Finite 
Element (FE) mesh by the mechanical integrity group where various analyses are 
done (i.e.: static analyses, creep, etc). The same mesh could then be used by the 
dynamics experts who will perform the modal analysis and evaluate the resonance 
risks. If there is an occurrence of a critical resonance, then a geometrical change 
is proposed and the iteration loop needs to start from the beginning.  
 
This process is illustrated in Figure 1.1 a. One drawback of this design loop is that 
the dynamics frequency check appears too late and thus if a resonance risk is 
encountered, there is not enough time to allow sufficient iterations. Additionally, 
using the full 3d detailed model in the dynamics analysis makes the time involved 
in meshing and modal frequencies estimation too long. The cooled turbine blades 
have intricate geometric details that deal with the cooling of the blade. The 
meshing involved in these blades is more complex than non-cooled blades. During 
the meshing process, if the geometric details are intricate, much time in geometry 
cleaning is required before meshing. The cleaning of geometries before meshing 
becomes higher with the complexity in the model. On the other hand, including 
excessive details in the mesh makes the size of the FE model so large that it could 
limit the dynamics calculations to blade-alone analyses, without the disk influence 
(e. g.: various nodal diameters). 
 
There is then a need to have a more efficient manner of estimating the modal 
frequencies in the initial design stage of the cooled turbine blades. The influence 
of the geometric details in the modal frequencies of a model has to be found so 
that only relevant features of the geometry are included in a simplified model. The 
simplified model could then allow having the dynamics check earlier in the design 
chain as in Figure 1.1 b, reducing costs and time. 
 
As a first step for achieving an efficient calculation, this study will focus on 
evaluating the influence of the cooling features in the estimation of the modal 
frequencies. 
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2 BACKGROUND 

 

2.1 Gas Turbine Overview 
 
A gas turbine is an internal combustion engine that uses air as the working fluid. 
Saravanamuttoo et al (2001) explain the conversion of chemical energy from the 
fuel and the working fluid into mechanical energy in the production of power inside 
a gas turbine. An example of gas turbine is represented in Figure 2.1 where the 
components are visible through a cross sectional view. Detailed explanation of the 
important components of the gas turbine is discussed later in this section.  
 

 
Figure 2.1 SGT 750 Gas turbine ; Hellberg (2011) 

 

The gas turbine consists of three important components: the compressor, the 
combustion chamber and the turbine. Refer Figure 2.2 to visualize the process of 
power generation in the gas turbine. 

 
Figure 2.2 Simple Gas turbine Stage;  Saravanamuttoo (2001) 

 
The air is drawn from atmosphere pressure through the inlet guide vane to the 
compressor where the compression of inlet air takes place and then, the 
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combustion chamber comes into play where the fuel mixes with the inlet air to 
combust and move further to the turbine to generate power.  
 
2.1.1 Compressor Section  

It is the responsibility of the compressor to provide high pressure flow to the 
combustion chamber with utmost efficiency. A single stage of compression 
consists of a rotating blade which is connected to a rotating disk (the rotor), 
followed by a stationary vane (or stator).  The flow area in the compressor blade 
and vanes are divergent. The inlet and the outlet guide vanes of the compressor 
are neither divergent nor convergent. They are arranged to provide the best 
orientation for the compressor and the combustor respectively. 
 

 
Figure 2.3 Compressor flow characteristics; Ganesh.,V (2010) 

 
 

Figure 2.3 shows the pressure characteristics of the flow for one stage in the 
compressor section. The physical mechanism of the compressor is to convert the 
rotary energy in to the gaseous energy. This conversion increases the total 
pressure (Pt) on which most of the increase is in the velocity of the fluid with a 
small increase in the static pressure due to the divergence of the blade flow paths. 
 
The efficiency of the compressor depends on the smoothness of the air flow in the 
section and it is affected due to the occurrences of friction and turbulence. Efforts 
are made to minimize losses and it is likely to occur due to the high pressure ratio 
outcomes generated.  
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The air leaves the compressor through the diffuser into the combustion chamber. 
The diffuser is critical in converting the velocity increase through the compressor 
section to static pressure. The static pressure reaches the highest at the outlet of 
the diffuser or inlet of the combustion chamber. 
 
2.1.2 Combustor Section  

The task of the combustor section is controlling of the burning of the large amount 
of fuel and air in an efficient manner. This must be achieved with minimum 
pressure loss and maximum heat release. In addition to that the combustion must 
be orientated in such a manner that overheating of the metal parts is avoided.  
 
The combustion takes place in the primary zone or the front end of the 
cans/burners. The primary air is used in the combustion process (approximately 
25 percent of the inlet air) and the rest of the inlet air in this section is termed as 
the secondary air or the dilution air. The secondary air controls the flame pattern, 
cooling of the liner walls and increases mass.  
 
The transition section is the rear end of the combustion liners and it is convergent 
in shape. The objective is to accelerate the gas stream and reducing the static 
pressure providing a good platform as an inlet to the turbine section. 
 
2.1.3 Turbine Section  

The physical mechanism of the turbine section is to convert the gaseous energy of 
the burnt fuel into mechanical energy. This is achieved by expanding the hot, high 
pressure gas from the combustor into lower temperature and pressure. The stator 
vanes increase the velocity of the gas and the rotor extracts the energy.  
   

 
Figure 2.4 Turbine flow characteristics;Ganesh.,V (2010) 

 

The stator vanes are convergent ducts that will convert the higher heat and 
pressure energy into higher velocity gas flow. Velocity, temperature and the 
pressure are sacrificed in order to rotate the turbine which in turn generates the 
shaft power.  
 
The efficiency of this section is on maximum conversion of the mechanical energy 
from the hot and pressure energy of the gases. The seal provided at the base and 
the shroud available at the rear stages of the turbine contributes to the efficiency. 
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The Turbine Inlet Temperature (TIT) is a critical factor in the design of a gas 
turbine.  
 

2.2 Cooled Turbine  
 
In modern gas turbines cooled turbines are the first stages of the turbine in which 
the cooling arrangements are provided. Cooling is critical at this section because 
the temperature is closer to or greater than the melting point of the material. In 
Figure 2.5, the first two stages of the turbine have cooling arrangements and are 
connected to the compressor. This means that the work done by this turbine is 
used to move the compressor and thus referred to as the Compressor-Turbine 
(CT). The next two stages are responsible for the transmission of the power and 
referred to as Power Turbine (PT).  
 
The turbine inlet temperature is an important factor in the design of the gas turbine 
and it is strived to maintain it as high as possible to obtain maximum thermal 
efficiency. In a modern gas turbine, the temperature is close to 1500 degrees 
Celsius.  
 

 
Figure 2.5 Turbine section after the combustion chamber ; Hellberg (2011) 

 

 

2.3 Turbine Cooling Design 
 
The cooling design has to bridge the gap between continuously increasing gas 
temperature and the pressures and the allowable material temperature, which 
have increased significantly in the recent years. The gas temperature is influenced 
by the focus on the turbine inlet temperature and thermal efficiency. 
 
2.3.1 Cooling Trend History 

The cooling design in the turbine section has improved the thermal efficiency 
indirectly by increasing the turbine inlet temperature. The cooling trend history is 
demonstrated from Lakshminarayana (1996). Initially, the cooling was not of much 
importance. The urge of increasing thermal efficiency paved way to make hollow 
blades which have internal flow passages to cool the blades. It began with simple 
flow path and later on emerged to produce complex cooling structures like ribs, 
matrix and many more complicated profiles.  
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Figure 2.6 Cooling trend history; Lakshminarayana (1996) 

 
As the years passed by, the cooling of the turbine blades have gained significant 
importance as the criterion of TIT became more critical in the design.  
 
2.3.2 Cooling Techniques 

The turbine cooling is divided into internal and external cooling techniques with the 
same motive. In the internal cooling, the heat is removed by the variation of 
convection and impingement cooling configurations, where the high velocity air 
flows and hits the inner surfaces of the turbine vanes and blades. The external 
blade cooling techniques is provided when the cold air is injected through the film 
cooling holes on the external blade surface in order to create a thin film cooling 
layer. The surface heat transfer occurring on the turbine blade is affected by 
combustor-generated high turbulence, laminar to turbulent transition, acceleration, 
film cooling flow, platform secondary flow and surface roughness, centrifugal 
forces and blade tip leakage and clearance.  
 
The blade displayed in Figure 2.7 consists of a zigzag cooling passage lined with 
the rib turbulators. Jet impingement technique is used to cool the leading edge and 
pin fin cooling technique with ejection is used near the trailing edge of the blade. 
The cooling path is different from that of the vanes as the effect of the rotation is 
considered and the flow of the coolant is altered accordingly.  
 
Rib turbulators are the most commonly used method to enhance the heat transfer 
in the internal multi flow cooling path. The rib turbulence promoters are typically 
cast on two opposite walls of the cooling passage.  
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Figure 2.7 Schematic of a modern, cooled gas turbine blade; Je-Chin Han (2013) 

 

The heat transfer performance of the ribbed channel depends on the aspect ratio 
of the blade, the rib configuration and the Reynolds number of the coolant flow. In 
the film cooling method, the air is extracted from the compressor and forced 
through internal cooling passages within the turbine blade and vanes before being 
ejected through discrete cooling holes on the airfoil surfaces. The air exiting these 
cooling holes forms a film of cool air on the component surface which protects the 
components from hot gas exiting the combustor.  
 
The trailing edge film cooling is a technique that gained popularity in the modern 
gas turbine due to its influence in the film cooling effectiveness and heat transfer. 
It is subjected to aerodynamic and structural constraints. The objective is to 
remove heat from the trailing edge region, since it is desirable to keep the trailing 
edge as thin as possible to minimize aerodynamic losses. The pressure side of the 
trailing edge is cutback to form the ejection slot (Figure 2.8). The ejected film 

Multi flow cooling 
path 
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cooling acts as an insulating layer to prevent hot gases from impinging in to the 
wall and also serves as a convective sink for the heat transferred to the suction 
side.  To counteract the structural weakening, the opposing walls forming the 
trailing edges are connected by arrays of pin-fin arrangement. The additional 
benefit of this arrangement is to act as turbulators for the flow from the ejection 
slot.  

 
Figure 2.8 Trailing edge cooling in high pressure turbine blade; Horbach (2011) 

 
Sundberg (2005) explains that matrix cooling is a complicated way of cooling but it 
provides the additional stiffness to the blade which will try to make it close to the 
blade without any cooling core. A matrix consists of two layers of opposite angled 
longitudinal ribs (Figure 2.9). The ribs create a system of channels, in which the 
cooling air changes direction continuously as it changes channel on its path 
through the airfoil.  

 
Figure 2.9 Cooling matrix; Sundberg (2005) 

 

A thin boundary layer is developed at each channel and it increases the heat 
transfer coefficient. The flow passes from one channel to another creating a swirl 
and increasing the turbulence of the flow. In addition to that, the heat transfer is 
increased due to the increase in the surface area from the presence of the 
longitudinal ribs. 
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2.4 Modal Analysis  

The goal of the modal analysis in structural mechanics is to determine the mode 
shapes and natural frequencies of a structure during free vibration. The single 
degree of freedom vibration system can be used to illustrate the modal analysis, 
as shown in Figure 2.10. 
 

 
Figure 2.10 Single degree of freedom vibration system 

 
The general idea of the single degree of freedom vibration system is described by 
the dynamic equation of motion 2.1. 
 

)()()()( tftkxtxctxm    (2.1) 

 
 
In the above mentioned form m represents the mass of the system,  c  represents 

the damping, k  represents the stiffness of the system, f  represents the forcing 

function, x  represents the acceleration,  x  represents the velocity,  x  represents 

the displacement and t  is the time. 
 
Assuming periodic excitation and periodic response, the equation can be mass 
normalized to determine the modal frequencies and the damping of the system as 
shown in equation 2.2. 
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Where  ωr is the damped natural frequency of the system. 
 
For the modal analysis, the complementary solution is formed by transforming the 
original differential equation in homogenous form.  This can be done by 
temporarily removing the damping and forcing function in this case. Laplace 
transforms can be implemented to determine the modal frequencies and modal 
vectors in the case of time domain. Otherwise, the equation can be transferred to 
the frequency domain by the Fourier transformation method to find the modal 
frequencies. 
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There are several methods for solving-multi degree of freedom systems. The 
classification of the methods is illustrated in Figure 2.11. The numerical solution 
from FEM is concentrated on in this project. 
 

 
Figure 2.11 Different methods of solving multi-degree of freedom systems; Barkanov 

(2001) 

 
Assembly of elements with local stiffness and mass descriptions is the basis of 
constructing computational models in the finite element method. It is assumed that 
the elements of the model are connected by finite number of nodal points. The 
field of displacements of each nodal point is determined giving the possibility of 
using the principle of virtual displacements to write the equilibrium equation for the 
element assembly.  
 
Barkanov(2001) states and explains the general algorithm of FEM and it consists 
of: 

 Presentation of potential energy for the system from the element assembly 

 Determination of boundary conditions present in the system for the analysis 

 Initial approximation for the finite element 

 Stiffness integration, finite element meshing and building of stiffness are 
done either analytically or by numerical simulation  

 Determination of the minimum potential energy where the solution is stable 

 Outputs of displacement and 

 Computation and output of stresses  
 
By constructing the finite element mesh, it is possible to obtain the component 
mass and stiffness matrices of the size of N x N, being N the number of degrees of 
freedom. The solution of the free response or homogeneous system (zero force) 
and no damping becomes an eigenvalue problem. The eigenvalues are then the 
square of the natural frequencies of each mode and the eigenvectors are the 
mode shapes of each specific mode. 

 

2.5 Turbine Blades Structural Dynamics 
 
 
2.5.1 Natural Frequency and Mode shape 

When the frequency of external forces matches the blade’s (or bladed disk’s) 
natural frequencies a resonance condition exists and thus High Cycle Fatigue 
(HCF) failure of the component might occur. The mode shapes is the way in which 
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the structure deflects at the natural frequency. For bladed disks, the mode shapes 
can be divided in to disk dominated and blade dominated mode shapes. 
 

 
Figure 2.12  Blade first order eigen modes ; Vogt (2005) 

 

Blade dominated mode shapes could be related to beam modes. Generally, the 
modes with the three lowest frequencies are two bending modes and one torsion 
mode which are defined by the position of the elastic axes. The two bending 
modes and the torsion mode are illustrated in Figure 2.12. Additionally, for blades 
with very high aspect ratio, the edgewise bending modes could be important. 
However, generally this is not the case for turbine blades. Other mode shapes that 
could be seen in blades are stripe mode and local deformation modes which are 
otherwise known as corner modes. The eigen frequencies of different modes vary 
with the rotational speed due to the effect of centrifugal forces.  
 

 
Figure 2.13 Disk mode shapes and nomenclature; Mayorca (2011) 

 
The disk dominated modes are defined with Nodal Diameters (ND) due to the 
presence of inflexion lines across the disk diameters. It is represented in Figure 
2.13.  
 
 
2.5.2 Excitation Forces 

Vibratory forces are the forces that excite the structure to vibrate and the highest 
resulting displacement amplitudes are obtained at resonance. In the case of gas 
turbine blades, the most common sources of excitation are vane passing 
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frequencies and running speed harmonics. Running speed harmonics are due to 
disruptions in the fluid flow path. The running speed frequencies are the multiples 
of the rotor operating speed. The multiples of the rotational speed are also referred 
to as Engine Orders (EO). 
 

 
Figure 2.14 Illustration of blade row interaction mechanisms; Mayorca(2011) 

 

Laumert (2002) did an investigation in which the main excitation mechanisms for a 
turbine stage were determined. In Figure 2.14, the main excitation mechanisms 
are illustrated. Wakes generated in the blade row interaction are classified as 
viscous interaction. The passing blades generate a change in the static pressure 
which is known as potential field perturbations. In the case of wide trailing edge 
turbine blades, vortex shedding is possible. Shock perturbations are caused by 
localized unsteady pressure and also due to the static pressure field change. All 
these mechanism are available in real life conditions resulting in an unsteady 
pressure distribution on the blade surface. 
 
2.5.3 Campbell Diagram  

Campbell diagram illustrates the crossings of the natural frequencies of the 
structure with the exciting forces.  
 
The possible resonance conditions are highlighted in Figure 2.15 with circles. 
When the engine orders crosses with the natural frequencies of the structure 
within the operating range, then it becomes a potential threat for the integrity of the 
structure.  
 
The difficulty in defining the resonance is that it normally considers only one 
isolated blade in its analysis. The typical blade-alone case means that the blades 
are treated as isolated oscillators. The concept of nodal diameter and hence the 
disk influence is not illustrated in the Campbell diagram.  
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Figure 2.15 Campbell diagram ; Mayorca (2011) 

 
2.5.4 SAFE Diagram  

 
Figure 2.16 SAFE Diagram ; Dello (2013) 

 
The Campbell plane is projected in another manner to show the same information 
in a clear and concise manner (Figure 2.16). This projected plane is the SAFE 
plane. The SAFE planes and Campbell diagram shares the same vertical 
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frequency axis. Instead of the operating speed on the horizontal axis, it is replaced 
with nodal diameter. Nodal diameter provides an insight to the mode shape of the 
bladed disk structure and also the shape of the varying force. SAFE diagram will 
reveal the true resonances. Note however that for many blade designs the 
conventional Campbell diagram view is sufficient, since the nodal diameter 
influence is small for designs with stiff disks versus flexible blades (e.g., 
compressor blades). 
 

 
Figure 2.17 Producing SAFE diagram from Campbell Diagram ;Dello (2013) 

 

In Figure 2.17, only the first family of tangential modes is plotted. In order to 
construct the SAFE diagram from the Campbell diagram, the frequencies at the 
different nodal diameters need to be known. The case 2 mentioned in Figure 2.17 
describes the shortcoming of the Campbell diagram interpretation. The 
interference of the first tangential mode with the 1 x NPF (Nozzle Passing 
Frequency) excitation is shown in the Campbell diagram, but the SAFE diagram 
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does not show this interference. On careful examination of the SAFE diagram, it is 
shown that the shape of the force at 46 nodal diameter does not match with 0 to 8 
nodal diameters. The second case justifies that the SAFE diagram contains 
enough information to accurately determine the occurrence of the bladed disk 
resonance.  
 
In the case of the cooled turbine blades, the evaluation of the frequencies for all 
the nodal diameters is a time consuming process and generally, they are done 
only for a limited set as the models are complex and large in size. Hence, lighter 
models are required to evaluate the frequencies at sufficient nodal diameters for a 
particular mode shape. These calculations imply that a sector of the disk and 
blade should be included in the FE model and cyclic symmetric boundary 
conditions should be applied at different nodal diameters.   
 
For the fully detailed cooled turbine blade, most of the elements are concentrated 
on the blade section, and thus for the simplification studies in this project, the 
blade alone is considered.  
 
2.5.5 Bladed Disk Mistuning 

Castanier et al (2006) investigated mistuned bladed disk vibration and states that 
there are always small deviation among the blades caused by manufacturing 
tolerances, wear and other causes. This is called mistuning which is a small 
deviation relative to the ideally tuned blade. Comprehensive modeling, analysis 
and understanding of mistuned bladed disk vibrations is critical in reducing the 
occurrence of HCF and improving the performance and reliability of turbines. 
 

 
Figure 2.18 3 Nodal diameter mode shape of a tuned bladed disk; Castanier  et al(2006) 
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Figure 2.18 shows the behavior of the mode shape in a tuned bladed disk where 
the cyclic symmetry models can be used. Figure 2.19 shows the mistuned bladed 
disk vibration model where the cyclic symmetry cannot be used as it highlights the 
non uniform displacement amplitude distribution of the mode shape in the bladed 
disk. 
 
 

 
Figure 2.19 Localized mode shape of a mistuned bladed disk; Castanier et al(2006)  

 
 
In the case of cyclic symmetry models (Figure 2.18), one section of the bladed 
disk is enough to simulate efficiently the full bladed disk. Mistuning cause a drastic 
change in the bladed disk dynamics and breaks the cyclic symmetry as well 
(Figure 2.19). Therefore modeling only one sector is not enough in this case, full 
bladed disk model is needed. Even with accelerated Monte Carlo simulation, these 
finite element models are heavy and non-feasible to simulate. Hence, the 
emergence of reduced order models comes into use for these heavy and 
complicated analyses.  
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3 OBJECTIVES 

In the initial stages of the aeromechanical design of turbine blades, the modal 
frequency check of 3d finite element models is important to be within the 
acceptable range in the Campbell diagram. The cooled turbine models consist of 
intricate geometric details which make the model heavy and time consuming. It is 
also difficult to perform for all nodal diameters.  
 
The main objective of this project is to obtain lower size 3d finite element turbine 
blade models but yet with sufficient accuracy for modal analyses. The following 
are the sub-objectives to achieve this goal: 
 

 Understand the influence of cooling features in the dynamic analyses for 
different cooled turbine blades  

 

 Obtaining the mesh detailing impact on the analyses and providing a 
process for cooled turbine reduced mesh sizes  

 

 Benchmarking the modeling process with the fully detailed model to 
address the industrial applicability of dynamic analyses with simplified 
models in terms of computational cost and accuracy  
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4 METHOD OF ATTACK 

To get an insight about the contribution of the cooling features in the estimation of 
modal frequencies, two representative cooled turbine blade models are assessed. 
The process of solving and estimation is illustrated in Figure 4.1. The history of the 
geometry details for the models is available in an NX CAD model. Different models 
are created depending on the detailing.  The finite element mesh of the different 
models is created. The models do not have the disk in it.  
 
Before doing the modal analysis, a mesh sensitivity study is performed so that the 
mesh influence in the modal analysis is eliminated. This mesh sensitivity study is 
done in the model without any cooling core.  
 

  

Figure 4.1 Flow chart of the process 
 

Different loading conditions are taken into consideration while doing the modal 
analysis. These modal analyses are performed to make sure that the difference in 
the results is only due to geometrical features and independent of boundary 
conditions.  
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Finally, the full modal analysis is performed with actual loading conditions and 
constraints. The different models are compared with the original model with the 
complete cooling details. The results of the comparison will provide an insight into 
whether they are dependent on the mass properties or the stiffness properties. 
The importance of geometric details in the modal analyses of a particular test case 
is noted and discussed. The possibility of modifying the density on the non-cooled 
blade to achieve dynamics characteristics of the cooled blade is brought up.  
 
Guidelines are formulated from the results and discussions for future 
improvements on the estimation of modal frequencies. 
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5 TEST CASE 

The first two stages turbine blades from SGT–750 are considered as test cases. 
These are part of the Compressor Turbine (CT) as they drive the compressor of 
the engine. The air that is used in the cooling of these turbine blades is drawn from 
the compressor section. The first stage blade is referred to as CT1 and the second 
stage blade is referred to as CT2. These two blades exhibit cooling features that 
are quite different and thus both of them are studied. 
 

5.1 First Stage Turbine Blade CT1 
 
5.1.1 Cooling Features 

The first turbine stage (CT1) is modeled and the cooling features that are of 
primary importance are cooling matrix, rib turbulator, film cooling holes and multi 
flow cooling path. The models are developed based on the detailing of the 
geometry involved in the turbine blade.  
 

 
Figure 5.1 Multi flow cooling path in turbine blade 

 

The multi-flow cooling path is the flow path for the cooling air in the turbine blade 
(Figure 5.1). The flow path is designed so that the heat transfer surface area is 
increased due to the zig-zag shape.  
 
The most complicated cooling feature in this blade is the presence of the cooling 
matrix (Figure 5.2).  It consists of two layers of oppositely angled longitudinal ribs.  
 
The cooling matrix provides the structure with an additional stiffness which is 
otherwise deprived from the structure due to the removal of material to form the 
cooling flow path.  The rib turbulators are small indentation marked on the surface 
of the flow path which assists in increasing the turbulence of the flow inside the 
cooling passage. The turbulence, separation of flow and also the mixing of the flow 
are the characteristics which contribute to the heat transfer occurring on the flow 
passage.  

Multi-Flow 
path 
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Figure 5.2 Rib turbulator and cooling matrix of CT1 blade 

 
 
The next important feature of cooling in the blade is the presence of the film 
cooling holes (Figure 5.3). The film cooling holes are also a complicated feature as 
they can be skewed relative to the surface of the airfoil. They are present on the 
leading edge and also on the tip of the turbine blade.  
 

 
Figure 5.3 Presence of film cooling holes in CT1 blade 

 
In this cooling method, the air is extracted from the compressor section and it 
maneuvers through the cooling path and as it exits through the film cooling holes, 
it forms a film of cooling air on the airfoil surface. It protects the surface from the 
hot gas exiting from the combustor. 
 
5.1.2 NX Models from Detail History  

The models are generated from the history of geometric detailing provided in the 
design of the blade. The models are generated in such a way that the influence of 
the features with respect to the variation in the modal frequency is identified. From 
the cooling features mentioned earlier, the models are formulated accordingly.  
 
 

Rib 

turbulator 

Cooling 
matrix 

Film cooling 
holes 
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5.1.2.1 Model 1 
 
The first model that was considered for calculation of modal frequencies had no 
cooling path or feature in it. It is also referred to as no cooling model (Figure 5.4). 
The model had solid inside and it does not have any hollow structure inside the 
model.  
 

 
Figure 5.4 CT1 Model 1(no cooling features) 

 
5.1.2.2 Model 2 
 
The second model generated includes the multi flow path only (Figure 5.5).  All the 
other features contributing to the cooling of the turbine were not involved in this 
model.  
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Figure 5.5 CT1 Model 2 (only multi-flow cooling path) 

 

5.1.2.3 Model 3 
 

 
Figure 5.6 CT1 Model 3 (multi-flow path and film cooling  holes) 

 

The model 3 has the multi flow path and the film cooling holes at the leading edge 
and also the tip of the turbine blade (Figure 5.6). This model was generated to find 
out the influence of film cooling holes and also the multi-flow path with respect to 
the modal frequencies for different modes.   
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5.1.2.4 Model 4 
 
The cooling features that are involved in this model are the cooling matrix and 
multi flow path (Figure 5.7). But, in this model, there was no film cooling holes and 
no rib turbulators. This model is created to determine the influence of the cooling 
matrix. 
 

 
Figure 5.7 CT1 Model 4 (multi-flow path and cooling matrix) 

 

5.1.2.5 Model 5 

 
Figure 5.8 CT1 model 5 (multi-flow path, film cooling and cooling matrix) 
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Figure 5.8 illustrates the cooling features in model 5, which include the cooling 
matrix, film cooling holes and multi flow path. The only cooling feature that is not 
present in this model is the rib turbulators. The model was generated to identify 
the influence rib turbulators with respect to the modal frequencies for different 
modes. 
 
5.1.2.6 Model 6 
 
The model has the complete cooling features which consist of cooling matrix, rib 
turbulators, film cooling holes and the multi flow path (Figure 5.9). This model is 
generated as a benchmark model for the other models to be compared with. The 
properties used to compare the models are the modal frequencies and mode 
shapes at the lower modes.  
 

 
Figure 5.9 CT1 Model 6 (all cooling features) 
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The loading conditions and constraints are varied for the different models and the 
modal analyses are solved in Abaqus. The results will be discussed in the 
subsequent chapters. A mesh sensitivity study will also be presented later. 
 

5.2 Second Stage Turbine Blade CT2 
 
5.2.1 Cooling Features  

The cooling features of the second stage turbine blade consist of ribs, rib 
turbulators and trailing edge cutback (Figure 5.10). The turbine blade in this stage 
has less intricate geometrical features than the first stage turbine blade. On the 
other hand, the size and the twist available in this blade are comparatively more 
pronounced than in the first stage turbine blade.  
 
 

 

Figure 5.10 CT2 cooling features 
 

The ribs are a very important cooling feature in this blade. The ribs compensate for 
the structural weakening that is caused by the introduction of the cooling flow path. 
The trailing edge ejection is the cooling technique that is used in the area where 
the temperature gradient is high but the transfer surface area is low. This could 
cause many complications. In that case, the trailing edge cutback profile supports 
the purpose to compensate the increase of transfer surface area and also 
increases the structural weakening caused by the trailing edge ejection profile.  
 

Trailing edge 

cutback 

Rib 

Rib turbulator 
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The rib turbulator in this model enhances the turbulence of the cooling flow. 
However, these structures are intricate and have much detailing which makes 
meshing and solving complicated in this section. 
 
5.2.2 NX Models from Detail History 

The NX models are formed according to the history of the detailing created for the 
cooling path. The ribs, rib turbulator and trailing edge cutback are some of the 
important cooling features that are involved in this model. The influence of the 
cooling features on the modal frequencies of different modes is the motive for 
developing the different models.  
 
5.2.2.1 Model 1 
 
 

 
Figure 5.11 CT2 Model 1 (no cooling) 

 

There is no cooling core in this model (Figure 5.11). This is solid in nature and it 
does not have any holes or hollow partition in it. The trailing edge has the tapered 
part and the trailing edge is closed. This model is the simplest model to mesh and 
solve. It is used here to show its deviation with respect to the model with the 
complete cooling core. 
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5.2.2.2 Model 2 
 
This model has the multi flow cooling path with ribs introduced to increase the heat 
transfer surface area and also to increase the effective length of the flow path 
(Figure 5.12). The ribs are the cooling feature that provides structural 
strengthening.  
 

 
Figure 5.12 CT2 Model 2 (multi-flow cooling path and ribs) 

 

5.2.2.3 Model 3 
 
The cooling features that are available in this model are the ribs, multi flow path 
and also the trailing edge cutback which are shown in Figure 5.13. The trailing 
edge cutback is the additional cooling feature that is implemented in this model. 
The direction of the wedge shaped surfaces in the trailing edge region is 
perpendicular to the radial direction of the model.  
 
This model is generated in order to investigate the influence of trailing edge 
cutback with respect to the modal frequencies.  
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Figure 5.13 CT2 Model 3 (multi-flow path, ribs and trailing edge cutback) 
 

5.2.2.4 Model 4 
 
 

 
Figure 5.14 CT2 Model 4 (complete cooling core) 



MSc Thesis Arokia Lourdu Marshall, Arokia   

 40 

 
This model is the complete cooling core model. In this model (Figure 5.14), all the 
cooling features are implemented. Ribs, multi flow path, rib turbulators and trailing 
edge cutback are some of the important cooling features that are available here. 
 
Rib turbulators are small indentation patterns that are present in the multi flow 
cooling path. This cooling feature creates turbulence for the cooling flow.  
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6 RESULTS AND DISCUSSION 

6.1 Mesh Sensitivity Analysis  
 
The CT1 turbine blade is here used to perform a mesh sensitivity study. The mesh 
sensitivity study is a process through which a robust mesh optimization is done so 
that there is no mesh influence or minimum influence towards the modal 
frequencies. The model that is used for the mesh sensitivity analysis is Model 1 of 
CT1, i.e., without cooling core.  
 
In this process, Model 1 is divided into three individual components and the 
components are named as airfoil, root and platform. This is illustrated in Figure 
6.1.  
 

 
Figure 6.1 Components selected for meshing process 

 

The airfoil region that is developed in the model is from the tip of the blade to the 
platform of the blade. The root region is from the platform of the blade to the fir 
tree region of the blade. The disk region is named after the region that has the fir-
tree structure and this structure connects the disk with blade. The disk region is 
the region that is fixed and this constraint is implemented for the modal analysis.  
 
The loading condition that is used is the centrifugal load. The constraint 
implemented is the fixation of the disk part. The mesh sensitivity analysis starts 

Disk 
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with a coarse mesh and progresses towards a fine mesh with smaller size 
elements.  
 
6.1.1 Root Optimization  

The different models are generated from the coarse mesh and it progresses to 
finer mesh sizes. The convergence criterion that is involved in this process is the 
modal frequency. Figure 6.2 shows the frequency convergence of mode 1 with 
increasing mesh size. The highlighted model in red color denotes the model that is 
the coarser model considered converged. The number of elements in that region is 
around 50,000 elements. The size and the number of elements are not changed in 
the disk region which has fixed number of elements.  It was found that the graphs 
followed a similar pattern for higher modes. The graphs are presented in Appendix 
B. Initially, the number of elements in the root region is varied with the other two 
regions having fixed number of elements which is displayed in Figure 6.2. After the 
optimization of the root region, the number of elements in the airfoil region is 
varied with the optimized number of elements in the root region and the fixed 
number of elements in the disk region which is displayed in Figure 6.3. 
 

 
 
 

Figure 6.2 Root mesh convergence; mode 1; CT1 
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6.1.2 Airfoil Optimization  

 

Figure 6.3 Airfoil optimization process of Mode 2 
 

The converged model that is taken from the process of root optimization is used as 
a base model for optimizing the airfoil mesh (Figure 6.3). In this optimization 
process, the number of elements is reduced by increasing the size of the elements 
in the airfoil region. The optimized model is highlighted in Figure 6.3 and considers 
the optimum mesh density in the airfoil and root. The mesh size of this final model 
will be kept almost constant for the models with different geometries.  
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Figure 6.4 Final model from the mesh sensitivity analysis 

 

The final mesh that is optimized from the process is displayed in Figure 6.4. The 
model is generated using the Hypermesh software and the number of elements, 
nodes and degrees of freedom are optimized (minimized) with the modal 
frequencies kept as criteria.  
 

6.2 CT1 Modal Analysis 
 
The 6 different models are taken from NX and imported in to Hypermesh. The 
meshing is done in Hypermesh with loading conditions and constraints being 
applied to the model. The solver deck is taken into Abaqus to be solved for modal 
analysis. 
 
The modal analysis of the CT1 models is performed with different loading 
conditions and constraints. The loading conditions that are applied are the 
following: 

 Temperature profile 

 Seal pressure 

 Centrifugal load and 

 Fixation of disk 
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6.2.1 Temperature Profile 

The temperature profile is implemented as a loading condition. The temperature 
profile corresponds to an operating condition ~30 degree  higher than nominal  
temperature  (Figure 6.5). The loading condition is obtained from an already 
existing Abaqus output file (.odb).  
 

 
 

Figure 6.5 Temperature profile from Abaqus result file 
 

The temperature distribution is included as a loading condition directly into the 
Abaqus solver input file after it is created from Hypermesh. The manner it is 
implemented is explained in Appendix A. 
 
6.2.2 Centrifugal Load 

The centrifugal load is an important loading condition which contributes to the 
modal frequency. The origin of this loading is due to the rotational effects of the 
turbine which pulls the structure in the radial direction. The centrifugal load is 
applied to all the mesh elements.  
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6.2.3 Seal Pressure 

The seal pressure is applied in the platform region where the seals are connected 
to the blade and the pressure values vary from the leading edge and the trailing 
edge of the blade (Figure 6.6). The pressure is applied at the radial direction of the 
rotating blade. The elements at which the pressures are applied are the 
connecting elements between the blade and the seal plates.  It is applied on only 
one face for the above mentioned elements.  
 

 
Figure 6.6 Seal pressure boundary conditions 

 
6.2.4 Disk Fixation 

Since no disk is included, the main constraint at the fir tree region in the three axes 
is because in reality, the root flanks are in contact with the disk slot which makes 
them fullr restrained. The fixation of the disk elements is explained in detail in 
Appendix A.  
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6.2.5 Full Modal Analysis  

After application of all the loads a static analysis is performed, including large 
deformation. The pre-stressed matrices are then the basis for the further modal 
analysis. The normalized modal frequencies of the first five mode frequencies of 
the 6 different geometries are plotted in Figure 6.7. The normalized modal 
frequencies are formulated from the ratio of modal frequencies of the different 
models to the modal frequencies of the converged (full-featured) model.  
 
 

 
 

Figure 6.7 Full modal analysis results  

 
From the plot it is inferred that Model 4 could be considered as size optimized 
model, having only around 0.2% difference compared to the complete cooling core 
model. Model 4 consists of cooling matrix and multi flow path. However, it does not 
have film cooling holes and rib turbulators, making it much lighter and easier to 
model than the fully detailed one.  
 
One important observation is that model 1 (no cooling core) does not show a huge 
difference to the more detailed models 4-6. The difference is around 12% for 
modes 1 and 3, but much lower for modes 2, 4 and 5. This is rather surprising, 
since this model has absolutely no details of the inner cooling core, making this 
model the easiest model to mesh, and the fastest to compute. 
 
Concerning models 2 and 3 most of the resulting mode frequencies are much 
lower than the detailed model. This shows the importance of modeling the cooling 
matrix as none of these two models consider it. This means that the blade is 
lacking the added stiffness and thus much lower frequencies are obtained.  
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6.2.5.1 Modal Analysis with Only Centrifugal Load 
 
The modal analysis is done with only centrifugal load as the loading condition and 
the constraints are fixation of disk and initial temperature. The loading conditions 
that are not involved in this modal analysis are seal pressure and temperature 
profile. Even when different set of loads are applied, the results show the same 
trends as in the actual  loading case, as seen in Figure 6.8. 
 

 Figure 6.8 Modal analysis with centrifugal load only 

 
The models can be grouped into 3 groups: group 1 is only model 1; group 2 
includes models 2 and 3 and group 3 will involve the models with converged 
modal frequencies (models 4, 5 and 6). 
 
6.2.5.2 Mode shape Comparison 
 
From the results of the modal analysis, three groups are formed. The mode 
shapes are analyzed to provide further insight to the behavior of models 2 and 3.  
 
It is seen that for mode 1, there is already a difference between group 2 and the 
rest of the groups (Figure 6.9). For higher modes, the second group is deviating 
even more from the other two groups with mode shapes localized to the trailing 
edge. Group 2 (models 2 and 3) is highlighted in Figure 6.10. There is structural 
weakening due to the absence of the cooling matrix. This creates localized mode 
shapes at the trailing edge.  
 
In contrast, all the first five mode shapes are predicted accurately with both groups 
1 and 3. This means that even the non-cooled model (completely solid core) 
predicts well the main characteristics of the dynamics of the blade. It can also be 
noted that details such as rib turbulators and film cooling holes have almost no 
effect on frequencies and mode shapes for the first five modes. 
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Figure 6.9 Mode 1 from the modal analysis 

 

 
Figure 6.10 Mode 2 to Mode 5 from the modal analysis; CT1 

 

6.2.6 Mass Scaling 

As observed before, the mode shapes are well described by the non-cooling 
model but the frequencies are generally underestimated. The differences of the 

Models 2 and 3  No Cooling Matrix 
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models in frequency depend on the model deviations in mass and stiffness.  One 
parameter that could be corrected is the density, so that the mass of the cooled 
and the non-cooled model is the same.  A simple manner to derive a new density 
could be done by knowing the ratio of the blade volume, as explained in equations 
6.1 to 6.3. 
 

Mmodel1=Mmodel6      (6.1) 

 

ρmodel1*Vmodel1= ρmodel6*Vmodel6   (6.2) 

 

ρmodel1= ( ρmodel6*Vmodel6 )/ Vmodel1   (6.3) 
 

 
The corrected density of model 1 is determined and included in the solver deck 
and then the modal analysis is re-run in Abaqus . The volume of the geometries is 
taken from the NX model.  
 
The frequency variation with model 6 as reference is plotted in Figure 6.11. In this 
case an unadjusted model 1 (no cooling) and a model 1 with new density (or mass 
scaled) are compared.  It is obvious that the frequencies of all the modes are 
shifted down. With this shift, the first three modes are closer to the zero line (more 
accurate) but modes 4 and 5 become farther apart. One could say that modes 1, 2 
and 3 are globally mass dominated. However, once the modes become more 
localized, then the global density change does not correlate in a positive manner. 
One can then think on a local change of the density depending on the real 
geometry difference vs. the simplified model. For example, it could be inferred that 
the mass near the trailing edge region should not be removed. 
 
 

 
Figure 6.11 Mass scaling on CT1 

The best solution from the mass scaling process is that an optimization of 
distributed density modifications could provide better result.  
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6.3 CT2 Modal Analysis 
 
For the second stage turbine blade models, the loads are implemented in a similar 
manner as in CT1, but with data related to CT2. All the loads are implemented in 
this model, but the values are different. In this modal analysis, there is no 
experimentation with different loading conditions. It is simulated with the full 
loading condition and after that mass scaling was practiced in the model with no 
cooling core. The material that is implemented in the CT2 modal analysis is a 
single crystal alloy. In the case of single crystal alloy, a crystal orientation vector 
has to be defined and used for all the elements in the mesh.  
 
6.3.1 Full Modal Analysis 

 
Figure 6.12 Full modal analysis results with respect to model number 

 
 

The 4 different models are plotted with their respective modal frequencies in 
Figure 6.12. It is shown that models 3 and 4 can be considered converged models 
with a maximum difference with the reference model (6) within the range of 1%. 
Model 2 (ribs and no trailing edge cutback ) is not in sync with the rest of the 
models. Model 1 (no cooling) shows a difference of around 5% for all the first 7 
modes when compared to the converged model. This frequency range was 
attained in CT1 only after the mass scaling. So, this is one of the surprising 
features exhibited by the modal analysis of CT2.   The difference in size of the 
models can be observed in Figure 6.13, where the number of elements is 
included. It is clear that model 3 is almost one-third of the size of model 4 but with 
only a difference of 1% in the modal frequencies. This clearly shows the potential 
of the FE size reduction for the dynamics check in an early stage of the design.  
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Figure 6.13 Full Modal Analysis result with respect to number of elements 

 
6.3.2 Mode Shape Comparison  

 
Figure 6.14 Mode 1 to 4 from full modal analysis results; models 1 to 4 from left to right 

 

 The mode shape comparison between the models is presented in Figure 
6.14 and Figure 6.15. Model 2, having the worst accuracy in frequency is 
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highlighted.  It can be seen that mode shapes 1 and 2 are predicted well by 
all the models, with only a slight difference in model 2. However, the 
comparison of higher mode shapes (3 to 7) highlights the difficulty for model 
2 to predict the mode shapes correctly. Instead, with this model, modes are 
mainly localized to the trailing edge. This is somewhat expected, since for 
this case the blade does not include the trailing edge cutback structures 
and consequently there is no support in the trailing edge. This results in an 
excessively flexible trailing edge region., which is obvious in mode shape 7 
(Figure 6.15). The structural weakening in this critical section causes 
localized mode shapes and also lower frequencies than for the real 
geometry.  

 

 
Figure 6.15 Mode shapes 5 to 7 for CT2; models 1 to 4 from left to right 

 
6.3.3 Mass Scaling 

Mass scaling is implemented in the CT2 model 1 which has no cooling core. The 
motive of mass scaling is to study if the modal frequencies would be closer to the 
converged modal frequencies for the different modes. To achieve this, the density 
has to be corrected in a similar approach as presented for CT1. In the case of 
CT2, the mass scaling made the results move farther away from the zero line 
(Figure 6.16). The original model 1 was already in the frequency range of 5 
percent. The mass scaled model 1 moved to a frequency range of 15 percent. 
Hence, mass scaling is not useful in the case of CT2.This might be due to the fact 
that in the mass scaling global change of density is introduced into the model 
which does not provide reasonable results. 
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Figure 6.16 Mass scaling results of CT2  
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7 SUMMARY AND CONCLUSION 

A parametric study has been performed in order to understand the effects of 
internal cooling-related geometrical features on the dynamic analysis of cooled 
turbine blades. Two distinct cooled blades have been considered for the analyses. 
One of the blades considered represents a typical cooled design of the first stage 
rotor blade of a compressor turbine. This blade included as key features the 
cooling matrix and film cooling. The other blade considered was a typical second 
stage rotor blade of a compressor turbine. This blade’s key cooling features were 
the ribs and the trailing cutback.  
 
It has been shown that for both blades the presence of turbulators is not required 
for the dynamic analyses. The frequencies obtained for models without this feature 
resulted in practically the same frequency and mode shapes as the full model. 
This is important to note, since the meshing of these details is highly time 
consuming and also the size of the mesh can be reduced in some cases by a 
factor of 3. 
 
Especially for the first stage blade, the film cooling holes also represent a detail 
which does not have a large effect on the prediction of the modal frequencies for 
first five modes (<0.2%). 
 
The most relevant cooling core features with respect to the dynamics are the 
cooling matrix, the ribs and the trailing cutback. These features play an important 
role on the stiffness of the blade and thus the final modal frequencies. 
 
On the other hand, one key observation is that the non-cooled model (solid blade) 
represents all the lower mode shapes for both blades in a good manner. The 
shape of the modes is fairly close to that of the fully detailed geometry. The 
frequency difference obtained for such model was in a range of ~10% for the first 
stage blade and ~5% for the second stage blade. This observation is quite 
positive, since not modeling the cooling core at all makes the mesh process 
substantially easier and also the mesh sizes could be reduced up to a factor of 10. 
These models could allow quick frequency checks in the very first stages of the 
design. Additionally, it is brought forward the possibility to improve the accuracy of 
the solid blade model by changes in density. In the present report, only a global 
density change was assessed to compensate for the added mass of the solid 
model. However, it is here proposed to apply localized density changes depending 
on the geometrical features of each blade.  
 
As a summary of the principal models used in this report that exhibit acceptable 
performance, Figure 7.1 and Figure 7.2 are included, showcasing the 
improvement in size depending on included features.  
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Figure 7.1 Comparison of CT1 turbine blade models 

 

 
Figure 7.2 Comparison of CT2 turbine cooled blade models 
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7.1 Future work 
 
This project provides an insight into the influence of different cooling features in 
the estimation of modal frequencies for two different test cases. This can be 
implemented in the cooled turbine blades also of other engines. 
It is proposed to study local changes of density and possibly stiffness in the non-
cooled model in order to obtain improved accuracy with respect to the fully 
detailed cooled model. 
A further reduction in time on the dynamics check can be achieved by the 
implementation of reduced order modeling, where the 3d Finite Element mesh 
would not be generated. A schematic of this process is presented in Figure 7.3, 
where the blade sections would be represented by reduced degrees of freedom. A 
process like this would highly increase the possibilities of necessary loops in the 
design chain, allowing sufficient iterations with the aerodynamic and cooling 
groups. 
 

 
 

Figure 7.3 Future objectives in a flow chart 
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9 APPENDIX A: GUIDELINES IN CREATING MESHES FOR 

COOLED TURBINES IN HYPERMESH VER12.0 AND MAKING IT 

COMPATIBLE FOR ABAQUS VER6.12 

9.1 Starting with Hypermesh 

Before working with Hypermesh , the geometry that has to be imported into 
Hypermesh has to be checked in NX for any modifications to be updated and the 
file format that has been saved in NX is UG (Uni-graphics) format. 

 

1. A working directory for the HM files must be created, so that the HM files 
can be saved in that directory. 

2. Right Click in the Desktop > Open terminal > hm12.  
3. Hypermesh ver12.0 will open and a dialog box User Profiles opens. In that 

dialog box, In the Application box, Abaqus is selected and in the scroll 
down option in the right will be activated as soon as Abaqus is selected. In 
the scroll down option, Standard3D option is selected. 

4. Uncheck the switch Always show at start-up and click Ok 
 

 
Figure 9.1 User Profile Option at the start up of Hypermesh 
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9.2 Importing geometry 

The simplified geometry to be meshed in Hypermesh is generated in NX. The 
directory of the geometry is required to import the geometry in to Hypermesh. 

 

1. Open File menu >Click Import option > Click Geometry option. 
2. In the Import Menu displayed on the left side of the screen, select UG in 

the scroll down menu for file type.  
3. Browse for the file to be imported and add it to the file selection box. 
4. In the import options box, the Scale factor is taken as 1 and Cleanup tol 

menu is selected as Manual and the value is 0.01 
5. Select the switch option Use native reader and click Import. 

 

Note:  The Cleanup tol option is the cleanup tolerance that is used while importing 
the UG file into Hypermesh and the units used for the cleaning operation is in 
millimeters.  

 

 
Figure 9.2 Import Menu in Hypermesh 
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A pop up menu appears after the import button is pressed.  In the UG Part 
Browser pop up menu, click Ok. Make sure that the Include invisible geometry 
option is unchecked.  

 

 
Figure 9.3 UG part browser menu in Hypermesh 

9.3 Geometry Cleanup  

The Cleaning up of geometry is critical for meshing. If this is not done, then, 
meshing complex shapes will be difficult and time-consuming. 

 

9.3.1 Suppress unwanted edges 

The edges that is not necessary for meshing in the geometry can be suppressed 
without altering the shape of the geometry.  

 

1. In the lower part of the screen, select Geom option. 
2. In the Geom option, select the option Quick edit. 
3. In the Quick edit option , Press the button line(s) next to toggle edge 

option. See Figure 9.4  Quick edit option in Hypermesh 
4. The edges that have to be suppressed can be selected by left clicking on 

the edge. In case of releasing an edge, right click on the edge at this option. 
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Figure 9.4  Quick edit option in Hypermesh 

9.3.2 Removing Fillets in the geometry 

The fillets are complex shapes that use a lot of elements in the meshing process. 
In the case of modal analysis, smaller fillets can usually be removed. 

 

1. In the Geom option, select the defeature option. 
2. In the defeature menu, select the option surf fillets. Now, you click the 

lines that are surrounding the fillets in the geometry and as all the sides 
enclosing the fillet are selected. Click find. See Figure 9.5  Defeature option 
in Hypermesh 

3. Then, the filleted surface to be removed will be highlighted in white. Click 
remove to remove the fillet. 

 

 

 
Figure 9.5  Defeature option in Hypermesh 

9.3.3 Splitting Surface or Additional trim 

Splitting surfaces or trimming surfaces are useful in simplifying geometry and also 
in creation of components for shell coating meshes. The Additional trim is useful in 
meshing of cylindrical or tubular components. 

 

1. In the Geom option, select the Quick edit option. 
2. In the Quick edit menu, split surf-line option is used to trim or split 

surfaces. See Figure 9.4  Quick edit option in Hypermesh 
3. The node is used as the starting point for the trimming and a line is selected 

perpendicular to the trimming surface. 
4. Sometimes, split surf-node option is used and it uses the node-node 

definition method to trim a surface. 
 

9.4 Creation of components 

The components are necessary for creation of shell coating elements. 3d tetra 
meshes can be created by two methods: 

 Volume tetra method and 

 Tetra mesh method. 
The Volume tetra method does not require a shell coating mesh, but, requires only 
an enclosed solid with minimum geometrical complexity. 
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The tetra mesh method uses an enclosed shell coating mesh to generate tetra 
meshes within the enclosed shell coating. This method is useful in creating mesh 
for complex structures. 

The shell coating elements can be created only if the volume is closed, in order to 
create closed volumes for the shell coating elements, new surfaces are created. 

9.4.1 Creating Surfaces 

Creation of surfaces with common edges is useful for creating and separating 
components. The Split surf-line command is used to trim surfaces. 

An example is the creation of the disk surface with creation of a new surface with 
common edges. New edges that enclose the surface are created with the use of 
the split surf-line command. Geom > Surface > Spline-filler method is used to 
create the surface and all the edges enclosing the surface are selected. Make sure 
that the switch Auto create is unchecked. 

 

In Figure 9.6 Surface creation in Hypermesh, the right side shows the disk with the 
surface of common edges. 

 

 
Figure 9.6 Surface creation in Hypermesh 

 
In case of models with a lot of internal surfaces, the Surface edit command is 
useful. Go to Geom > Surface edit > trim with surfs/plane option.  

 

9.4.2 Mask / Unmask entities 

In order to view or work with the internal surfaces of the model without deleting the 
outer surface, a masking operation is used.  The Mask icon on the left side of the 
screen is pressed and the outer surfaces can be hidden for editing internal 
surfaces. 



MSc Thesis Arokia Lourdu Marshall, Arokia   

 65 

 
Figure 9.7  Masking entities of a model 

 
In Figure 9.7  Masking entities of a model, the right side has the outer surfaces of 
the airfoil being masked, to show the internal cooling profile. Now, the trim with 
surfs/ plane command is used to separate the fir tree part from the rest of the 
model.  

 

 
Figure 9.8 Surface edit option in Hypermesh 

 
In Figure 9.8 Surface edit option in Hypermesh, the right side for the trim with 
surfs/plane, check the switch trim both option and select the newly created 
surface first and then click the surfaces that have to be trimmed in the second 
option. Click trim option and you will get the left side of the Figure 9.9 Component 
creation in Hypermesh.9 

 

 
Figure 9.9 Component creation in Hypermesh 
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In the left side of Figure 9.9 Component creation in Hypermesh, the disk 
component is created and separated from the rest of the model. But, there is an 
internal surface that is not necessary and it is deleted by clicking Geometry > 
Delete> Surfaces.  

 

Now, the surfaces that are displayed in Figure 9.8 Surface edit option in 
Hypermesh  have to be moved to a new component and that can be done by 
going to Tools > Organize > surfs > displayed > move. Do not use the option 
copy as it will have this surface retained in the previous component as well. 

 

Note: The components that are created for 2d shell coating meshes should start 
with “^” symbol so that the component will not be exported to the solver deck files.  

 

9.5 2d Mesh creation  

For creating shell coating mesh, 2d option is selected from the bottom of the 
screen and then, automesh is selected. The automesh dialog box is as in Figure 
9.10 Automesh option for 2d mesh in Hypermesh 

 

 
Figure 9.10 Automesh option for 2d mesh in Hypermesh 

 
The above mentioned dialog box contains the different methods of generating 
shell coating elements. Size and bias method is the simplest by denoting the 
element size and biasing the deviation of the element. 

 The size of the element to be generated is specified in the box element 
size. 

 Mesh type scroll down menu contains the different element types that are 
available for shell coating elements. R-trias is selected to generate good 
tetra 3d meshes. 

 Elems to current comp option is used to create the elements for the 
current selected component. The component can be made current by right 
clicking on the component available at the Model menu on the left side of 
the screen and selecting Make current option. 

 Second order option is available in the scroll down menu and it is used to 
create the second order trias or quad elements accordingly with the mid 
side nodes in the elements.  

 Keep connectivity option is used to keep connectivity with the neighboring 
and the connected components to the current component while generating 
the shell coating elements.  

 Make sure that the options align , size and skew are switched off.  

 Select the surfaces to be meshed by selecting the surfs option and click 
mesh to see the generated mesh for further modifications. 
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The interactive mode of meshing is used to override the automesh feature and 
provides control over the mesh density, biasing and other parameters while 
meshing. This is an intermediate phase between the automesh feature and the 
final mesh. See Figure 9.11 Interactive mesh mode in Hypermesh 

 

 
Figure 9.11 Interactive mesh mode in Hypermesh 

 

 Density option is used to control the element size of the overall mesh 
elements as well as the number of elements to be available at each edge. 
The number of elements in the edge can be increased by left-clicking on the 
number displayed on each edge and decreased by right-clicking on the 
number displayed. 

 Mesh style option is used to change the element type, the mapping of the 
elements in the mesh. Make sure that the options skew, smoothing, size 
and align options are unchecked. 

 Check option can be used to do an initial element check of the 2d mesh 
and adjust the density or the mesh style according to the result of the 
element check. 

9.6 Element Check of 2d mesh 

Once the 2d meshes are generated for all the partitions or components in a model, 
the elements have to undergo a series of element checks, so that, they produce 
good, consistent 3d tetrahedral elements that are compatible with the Abaqus 
solver. 

 

9.6.1 Minimum angle check 

Go to Tools > Check elems > 2d and the min angle option is used to display the 
mesh elements that are below the specified angle. The minimum angle 
requirement for the Abaqus solver is 10 degrees.  

In case of elements that are below the minimum angle requirement, the save 
failed option is used to save the elements that don’t fit the criteria. See Figure 
9.12  Element check option in Hypermesh 

 

 
Figure 9.12  Element check option in Hypermesh 
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 Once the elements are saved, the elements can be displayed by clicking 
Mask icon> elems > retrieve > Mask > Reverse. Delete these elements by 
clicking delete > elems > displayed > delete entities. 

 Unmask all the elements and click tool >edges > comp > displayed and 
then click free edges option on the right, to visualise the free edges in the 
model. 

 The nodes available in the free edges can be numbered by going in to 
tools> numbers > nodes > displayed > on.  

 

Note:  Never use the option all for deleting or masking elements for working in the 
current component, because using the option all will activate even the components 
that have been hidden. 

 

Shell element can be repaired by using the edit element, replace and 
split/combine commands available under the option 2d in the bottom part of the 
screen. In Figure 9.13 Replacing node with another node by using replace 
command, the repairing of elements that are having small minimum angles is done 
by using the replace command to replace the nodes. 

 

 
Figure 9.13 Replacing node with another node by using replace command 

9.6.2 Free edges 

The Model should be checked for free edges every time an operation is made on 
the elements, because the 3d tetra meshes will not be formed unless the shell 
coating elements are enclosed. The free edges can be checked by going to Tools 
> edges > comps > displayed and clicking free edges on the right side. 

 

The free edges will be highlighted in red colour in the screen and if there are no 
free edges, then the ^edges component will not be created on the Model menu. 
The free edges are formed due to a lot of reasons and some of them are: 

 When the edges are released, they form as free edges. 

 The overlapping of shell elements in different components. 

 The shell elements which are not enclosed will have free edges. 
 

Identify the root cause of the free edges, to eliminate them in a simple way. 
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9.6.3 Jacobian 

The Jacobian of the element is mainly dependent on how skewed the element is. 
So, if the element satisfies the minimum angle criteria, then, the Jacobian will not 
be an issue. The Jacobian can be checked by going to Tools > check elems > 2d 
> Jacobian option. For further reference, refer to Figure 9.12  Element check 
option in Hypermesh 

 

The Jacobian that is required should not be less than 0.5 for it to be compatible 
with the Abaqus solver. 

 

9.6.4 Penetration 

The penetration of the elements is critical in the development of 3d tetra meshes. 
The presence of penetrated elements in the shell coating elements will not allow 
the generation of 3d tetra mesh as the meshing process will be stopped due to the 
input mesh for 3d tetra being self-intersecting.  

 

Go to Tools > Penetration > elems > displayed and click check on the right 
side. If there are elements showing intersection or penetration, then, they are 
formed due to overlapping of shell elements within the component or between two 
components. In Figure 9.14 Penetration menu in Hypermesh, the intersecting and 
the penetrating elements will be displayed by left clicking on those options. 

 
Figure 9.14 Penetration menu in Hypermesh 

9.7 Creation of 3d tetra mesh 

The 3d tetra mesh is easier when all the 2d shell coating meshes are checked. 
The partition of the shell coating meshes is used to generate the 3d tetra volume 
mesh. By clicking 3d > tetramesh > Tetra mesh 
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Figure 9.15 tetramesh option in Hypermesh 

In Figure 9.15 tetramesh option in Hypermesh, the elems option is used to convert 
the quad shell mesh into triangular elements and check the switches fix comp 
boundaries and update input shells. Click mesh to mesh the 3d tetra mesh. 

Mesh to current comp option is used to create the 3d tetra elements and save 
them to the current component. 

 

Note: The common surfaces between partitions should have the elements being 
included for creating 3d tetra mesh, otherwise the 3d tetra mesh will not be 
created; exiting with the error the shell elements are not enclosed. 

 

9.8 Quality tetra check 

Location: Tool -> check elems -> 3d menu in the bottom panel. 

 

The most important check, which corresponds to ABAQUS Quality measure, is 
vol skew. The ABAQUS value and Hypermesh value are related as 

 

vol skew = 1 – Quality measure 

 

For example, if we want to limit quality measure to 1.E-5 in ABAQUS then HM 
volume skew is to be set as 1.-1.E-5=0.99999. 

 

If there are elements that do not fit this criteria, then the elements will be found 
overlapping each other or having a very small skewed volume almost like a 2d 
shell coating mesh.  

 

9.9 Creation of Element / Node sets 

The element and node sets that are required for loading, boundary conditions and 
contact interaction are created by going to Analysis > entity sets  

 

 
Figure 9.16 Entity set option in Hypermesh 

 
The entity sets can be created for either elements or nodes and the nodes can be 
arranged in an orderly or random manner as well.  
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9.10 Scaling  

Scaling down is an important operation to be done as the Model that has been 
imported into Hypermesh was in millimetres and in Abaqus, all the parameters are 
considered in SI units and hence, the model has to be scaled down to meters.  

 

Location: Tools > Scale> elems 

 

Click on the option elems and displayed to scale down all the 3d tetra meshes 
into meters. In Figure 9.17 Scaling option in Hypermesh, the x scale , y scale and 
z scale values are registered as 0.001 to convert the model from millimetres to 
meters. 

 

 
Figure 9.17 Scaling option in Hypermesh 

 

Note: The scaling down operation should be done only when the entity sets and 
the 3d tetra elements are created. Do not scale down before the entity sets are 
created. 

 

9.11 Loading Conditions and constraint definition 
 
In the Hypermesh menu bar, since the solver is Abaqus, the preferences are set to 
Abaqus. In order to change or select the appropriate preferences, go to 
Preferences -> User Profile. In the preferences pop-up menu, select the 
appropriate solver. 
 
In selecting the initial condition, in this case, the temperature and fixed constraints 
are used.  Since the creation of the element and node sets are already mentioned, 
the next step will be the generation of the load collectors to incorporate the 
loadings in the model. 
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Figure 9.18 Load collector pop up menu in Hypermesh 

 
 
Create a load collector to which the initial conditions are assigned. Right click in 
the model browser and go to Create -> load collector. The Load collector pop-up 
menu appears and in that menu, enter a name for the load collector. In the card 
image scroll down menu, choose initial condition and check options card edit load 
collector upon creation and close dialog upon creation and finally, click create.  
 
Since the solver is Abaqus in this case, the Load step browser pop up menu is 
used to control and see the overall load conditions. Go to Tools -> Load step 
browser 
 
In the menu, select initial condition and click edit, to open the initial condition pop 
up menu. Select boundary on the left hand side of the menu, to create boundaries 
for the initial condition. The entity set is already created before scaling down. 
Select the entity set to which the boundary condition is to be applied. In the 
Boundary condition box, the node sets have to be assigned.  
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Figure 9.19 Initial conditions browser in Hypermesh 

 
On the right hand side of the initial condition browser, there are columns 
mentioned as Nset which means the node set to which the boundary has to be 
assigned. The column 1st dof is used to describe the degree of freedom or the axis 
that has to be implemented in the boundary condition and the last dof column is to 
provide the maximum number of axis that has to be involved in that particular 
boundary condition. For example, in a condition of keeping a particular node set 
fixed, the 1st dof option will be set to 1 and the last dof option will be set to 3 to 
suppress motion in all three directions.  In the initial conditions, the magnitude is 
mentioned as zero by default. The load condition is assigned automatically when 
you click update. In a similar manner, the temperature constraint can be done. 
Click the temperature option on the left side of the browser. On the right side, 
define the element sets to which the temperature constraint should be assigned. 
 
The loads that are being implemented in this model are: 

 Temperature profile from an output file from Abaqus 

 Seal pressure  and  

 Centrifugal force 
 

9.11.1  Pressure definition 

The pressure profile is implemented in the model on the seal region for this case. 
The direction of the pressure is in the radial direction. First, a load collector has to 
be created or assigned to have the seal pressure parameters in it. The procedure 
for creating a load collector is discussed earlier. The only difference is that in the 
scroll down menu for card image, select history. This option is used to use the load 
collector for load steps rather than that of the initial condition. Go to Analysis -> 
Pressure. 
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 Figure 9.20 Pressure menu browser in Hypermesh 

 
In the pressure menu browser, the elements to which the pressure has to be 
implemented are to be selected and in the magnitude option, the pressure value is 
entered. The node on face is the option where the face at which the loading acts is 
defined and the nodes are selected from the selected elements in such a way that 
the face is defined properly and precisely. Click on the option ‘create’ to create the 
pressure profile.  
 
Note: Once the Pressure is created, it is important to activate the created loading 
condition into the analysis. It is done by checking the load collector in the load step 
created in the load step browser. 
 
9.11.2  Centrifugal force definition  

The centrifugal force is the force exerted on the model at a particular operating 
speed. The load collector is created with the card image represented as history. 
The load step is initially generated before defining the load collector with the 
loading parameters. For creating a load step, go to Tools -> Load step browser. 
The load step browser opens and in the name column, click the box below the 
initial condition and click edit to enter the name of the newly formed load step. In 
order to edit the parameters in the load step, click the load step and then click edit. 
  

 
Figure 9.21 Centrifugal loading option in Hypermesh 

 
In the load step browser, the centrifugal loading option is under the DLOAD option 
of the Abaqus solver. Click on the load collector to which the loading should be 
implemented and on the right side of the browser, the element set is defined with 
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the value and the direction at which the loading is implemented on the model. 
Since the loading is centrifugal, the rotation axis  of the model is mentioned with 
the help of the ‘coord’ options in the browser and click update to include the 
loading in to the load step. 
 
9.11.3  Temperature profile definition 

The temperature profile definition is easier to implement directly in the input file of 
the Abaqus solver. The temperature profile is an Abaqus output file in this case. If 
it is a CFD result, then, another method is used to implement the temperature 
profile from a CFD result. 
Some of the options that have been incorporated in the temperature profile 
definition are as follows: 

 The interpolate option is used when the mesh in the output file is different 
from the present model. 

 The absolute exterior tolerance option is used in relation to the interpolate 
option and set this parameter equal to the absolute value (given in the units 
used in the model) by which nodes of the current model may lie outside the 
region of the model in the output database specified by the FILE parameter’ 

 The word FILE is used to define the path of the temperature profile that is 
used in the model. 

 
Note:  The Temperature profile is included in the model by following the syntax of 
the example below. The asterisk symbol is used to indicate any input parameter in 
the model which is compatible to the Abaqus solver.  
 
*TEMPERATURE, FILE =mgtxCT2_stat,INTERPOLATE,ABSOLUTE EXTERIOR 
TOLERANCE=0.02 
 
 

9.12  Exporting to Abaqus 
 
The model generated is transferred as an Abaqus input file.  Ensure that all the 
parameters and components that have to be included in the solver deck are active. 
Go to File-> Export-> Solver deck 
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Figure 9.22 Export browser in Hypermesh 

 
In the Solver deck browser, Select the file type scroll down menu as Abaqus and 
the template is Standard 3d and the path of the file is defined in the file scroll down 
menu and the export options are opened to view more options. The input file can 
be customized by selecting the custom option in the export scroll down option. 
Then, the entities that are required to be exported are kept active in the entity 
browser. Check all the options mentioned below which are include connectors, 
Write HM comments, Prompt to save invalid elements and Prompt before 
overwrite. Click export to export the solver deck into the mentioned path and the 
file extension will be .inp in the case of the above mentioned example. 
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10 APPENDIX B: RESULTS OF MESH SENSITIVITY ANALYSIS 

10.1 Mode 2 – Root Optimization  
 

 
Figure 10.1 Mode 2 root optimization process 

 

10.2 Mode 3 – Root Optimization  
 

 
 

Figure 10.2 Mode 3 root optimization process 
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10.3 Mode 4 – Root Optimization  
 

 
Figure 10.3 Mode 4 root optimization process 

 

10.4 Mode 5 - Root Optimization  
 

 
 

Figure 10.4 Mode 5 root optimization process 
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